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Chapter 1

EvenMore 0.4beta3 - AmigaGuide® Documenta-
tion

1.1 EvenMore 0.4beta3 - AmigaGuide® Documentation - by Johan Björnson

_/_/_/_/ _/ _/ _/_/_/_/ _/_/_/ _/ .
_/ _/ _/ : Beta testers:

_/_/_/ _/ _/ _/_/_/_/ _/ _/ _/_/_/_/_/ :.
_/ _/ _/ _/ _/ _/ _/ ¦: Johan Björnson
_/_/_/ _/ _/_/_/ _/ _/ _/ |¦ Mikael Grahn
___________________________________________ || Per Reidar Verlo
http://planb.thegap.com/ || Dominique Neveu
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯ || Tony Hazel
Program : EvenMore || Andrew Holt
Type : Text viewer (Freeware) ||
Version : 0.4beta3 ||
Code : AmigaE 3.3a ||

||
EvenMore ©1996-1998 by Chris Perver ||
ReqTools ©1991-1994 Nico François, ||

©1995-1998 Magnus Holmgren ||
||

-----------------------------------------------------’‘------------------------
-------------------------------------------------------------------------------

1.2 Choices

Contacting cHRISPi

Files in the Archive
Copyright Agreement
Disclaimer

Requires
Installation
Main Features
Introduction
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Usage
Arguments from CLI
Arguments from Workbench

Tooltypes
Window Positions
Font
Public/Custom Screens

Editor

Preferences File
ARexx Port

Menu items:
The Project Menu
The View Menu
The Search Menu
The Execute Menu
The Settings Menu

Additional Controls:
Movement
File Loading

History
Bugs
To Do
Author
Help
Thanx’n’Greetz

1.3 Files in the Archive

The EvenMore executables and sources are copyright © 1996-1998 by Chris Perver
and the ReqTools.library is copyright © 1991-1994 by Nico François and copyright
© 1995-1998 by Magnus Holmgren.

The files in this archive are the following:-

EvenMore (dir)
rexx (dir)
Icons (dir)

EM1.info EM2.info
program_icon.info program_icon2.info

libs (dir)
reqtools.library

env (dir)
evenmore.config

Nostalgia (dir)
EvenMore033.lha

Docs (dir)
evenmore.doc evenmore.doc.info
EvenMore.guide EvenMore.guide.info
EvenMore.readme EvenMore.readme.info
FactsOfEvolution.quotes FactsOfEvolution.quotes.info



EvenMore 0.4beta3 - AmigaGuide® Documentation 3 / 32

microslick.readme microslick.readme.info
Docs.info evenmore
EvenMore.info Icons.info
Nostalgia.info

EvenMore.info

1.4 Copyright Agreement

This archive can be distributed by commercial or private companies, profit
making or otherwise, as long as the following rules are applied.

1) Permission to distribute this archive, or any part of it, in any form
requires express permission and consent of its author in writing (Email
please, but letter also accepted if necessary).

2) The contents of this archive must remain intact and unaltered. This archive
is permitted to be distributed so long as all the files described are
included and are not malformed, edited, changed or modified in any way, by
accident or intent.

3) The version distributed must be the latest release. (Check on aminet, or
email me)

4) If the program is distributed by any company that fits into the term
given above (Including, but not limited to paper magazines, disk magazines,
internet magazines, etc.) through any form of distribution methods
(Including, but not limited to magazines, CD, disk, FTP, email, etc.), I
demand that a free copy of that particular distribution (Including, but not
limited to magazines, CD, disk, FTP, email, etc.) be posted (free of charge)
to me as soon as it is published or released.

5) This archive may be distributed and advertised by public domain libraries,
as long as no profit is made on the program, and the price is no higher than
the cost of a disk, copying and distribution costs. This is freeware! You
can’t charge people any money for it!

--- EXCEPTIONS -----------------------------------------------------------------

1) This archive may be freely distributed on Aminet disks, Aminet
archives on-line, Aminet BBS and FredFish disks, no permission necessary.

1.5 Disclaimer

I HEREBY DISCLAIM ALL RESPONSIBILTIES FOR THE USE OR MIS-USE OF THIS SOFTWARE.

THIS SOFTWARE IS PROVIDED ’AS IS’, AND IS SUBJECT TO CHANGE WITHOUT FURTHER
NOTICE. THERE ARE NO GUARANTEES THAT THIS SOFTWARE WORKS, HAS NO BUGS, AND THAT
IT WILL NOT HARM ANY OF YOUR EQUIPMENT OR SOFTWARE ETC. BY USING THIS SOFTWARE,
YOU AGREE THAT ANY DAMAGES INFLICTED ARE THE TOTAL RESPOSIBILITY OF NONE OTHER
INDIVIDUALS, OR GROUPS, BUT YOURSELF, AND YOU MUST MEET THE EXPENSES TO COVER
THE DAMAGES. THIS AUTHOR WILL NOT BE HELD RESPONSIBLE FOR ANY DAMAGES THAT MAY
BE CAUSED, EITHER DIRECTLY OR INDIRECTLY BY USING THIS SOFTWARE. BEFORE USING
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THIS PROGRAM, BACK UP ALL IMPORTANT SOFTWARE AND FILES, AND MOST OF ALL, READ
THE MANUAL BEFORE PROCEEDING! AS I CANNOT RECOMPENCE FOR LOSSES. (INCLUDING, BUT
NOT LIMITED TO LOSS OF BUSINESS, LOSS OF SOFTWARE/HARDWARE OR LOSS OF
SANITY/HAIR). BACK UP, OR SHUT UP!

---+= USE THIS SOFTWARE AT YOUR OWN RISK =+-------------------------------------

1.6 Requires

OOO OOO OOO
OO OO OO OO OO OO OO
OO OO OO OO OO
OO OO OOO OO OOOOOO
OO OO OO OO OO
OO OO OO OO OO OO
OOO OOO OOOOO

o ReqTools.library 37+ (Included)

1.7 Installation

1) Simply copy ’libs/reqtools.library’ to ’Libs:’, if you haven’t already got
it, or haven’t got a version later than 37.

2) Then copy ’EvenMore’ and ’EvenMore.info’ to somewhere on your command line,
like ’C:’

3) Then edit the file ’Env/EvenMore.config’ to suit your own taste, and the
move it to ’ENVARC:’ and ’ENV:’.

Or you can run the program and set the settings the way you want them, and
then save them.

1.8 Main Features

Main features
-------------

o Scroller window allows easier moving about documents.
o AppWindow, AppIcon and AppMenu makes loading files easy. Not only can you

drag files onto them, but also drawers, and a requester will appear!
o Totally font sensitive, and you can select which font to view the text in.
o Tooltypes and preference file(s) for configuring, and you can configure

the settings while EvenMore is running too.
o Can open the window on any public screen and move between them.
o Can create it’s own public screen to run on.
o Developing ARexx port for remote control.
o Supports the numeric keypad and mouse movement.
o Very clean and smooth scrolling.
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o String and pattern finding functions.
o Bookmarks for remembering positions in the document.
o Quick load listview for loading documents fast.
o Slightly configurable GUI for quick access to features.
o File loading uses AsyncIO.
o Can load multiple files.
o Help available by pressing the help key.
o Gadget help bubbles.
o User-configurable filetypes, for passing certain files to different programs.
o Uses EasyGUI, the best GUI in the history of the world.
o Uses ReqTools library.

1.9 Introduction

The AmigaOS is a excellent operating system. Even the last OS before Commodore
ran out of money (OS 3.0) can’t be touched by Windoof and other operating
systems. So why spoil it now? Commodore also brought in features such as Screen
and Icon fonts, which could be proportional. And proportional fonts look so much
more nicer. So that is why I decided to have a bash at designing a nice looking
text viewer to complement Workbench. Well, that is partly the reason. The other
part is, I wanted to program... I was thinking about C, and then I just happened
to see what E could do and I was hooked! So this is my grand contribution to the
Amiga :). It hasn’t much features now, but it will get better.

Anyway. Before I didn’t realize how much code was involved in just doing the
simple things like opening a window with menus and printing text. In a basic
language, there are commands available for just about anything under the sun. I
could have written this program in Blitz Basic easily in a couple of lines, but
the resultant code would have turned out twice as large. What makes it worse is
I am just learning a new language, and I haven’t encountered all this operating
system code before. I need a book (Or similar) that would show me common
routines of doing things in the Amiga’s operating system using AmigaE, no C
here, as I don’t know the syntax (I wish I did, as there is a phenomenal amount
of C source on Aminet, and there is software and books that literally grow on
trees - Heheh, literally, as books ARE made out of paper ;).

1.10 Usage

EvenMore takes two arguments when running from CLI and just
one when running from Workbench (Which is drawers or files).

o You can specify multiple paths and/or files for the argument.
o The second arguments uses the keyword ’PREFS’, and allows you to sepcify
a preference file to use. Make sure you use ’PREFS=<config file>’

1.11 Arguments from CLI

If you do not specify any filenames, a requester will pop up allowing you to do
so. Once you have selected the file you wish to view, a window will open
displaying the contents.
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e.g. EvenMore S:User-startup PREFS=ENV:EvenMore.prefs
EvenMore Docs:EvenMore S:User-startup S:Startup-sequence

1.12 Arguments from Workbench

You can either shift-select multiple files or drawers with EvenMore (Holding
shift, left click on the EvenMore icon, then double click on a file), or if you
simply double click on the EvenMore icon, a requester will allow you to choose a
file.

1.13 Tooltypes

There are also several tooltypes for setting your preferences when running the
program from workbench. These are:

WINDOWPOS=0/0/640/256 The position of the window on the screen in
pixels

TEXTOFFSET=5/5/5/5 The number of pixels between the border and
the text

FINDHORIZ=0 0=No movement, 1=Left justified,
2=Centre justified

SEARCHNOTIFY=[ON/OFF] If true, when you search for a word in the
document a requester will appear telling you
which line the word was found at

SMOOTHSCROLL=[ON/OFF] If true, when the text is scrolled, it will
slide across the window, and gradually slow
down

QUITREQUESTER=[ON/OFF] If true, a requester will ask you to confirm
that you wish to quit the program

BORDERTEXT=1 1 = Box, 2 = Bevel, 3 = Bevel reccess drawn
around the text

BORDERGADGETS=1 1 = Box, 2 = Bevel, 3 = Bevel reccess drawn
around the gadgets

GADGETSOFFSET=2 The number of pixels between the gadgets and
the border/window

BORDERSOFFSET=2 The number of pixels between the borders and
the edge of the window

GADGETSPOS=1 The layout of the gadgets. 0=Both top, 1=Top
and bottom, 2=Both bottom

SWAPGADGETS=OFF If true, the load and search gadgets will
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exchange places

FILLBORDERS=3/3 Fill the window border/gadget gap with this
pen

DITHERFILL=0/0 The border/gadget fill will be dithered

ADDSCROLLERS=2 Which scrollers will be added to the window

PAGEOVERLAP=0 The number of lines that will overlap when
scrolling by a page

APPICONPOS=0/0 Position to place AppIcon when iconified

STARTAPPIFIED=0 0=Show, 1=Iconify, 2=Menufy on startup

CLOSEAPPIFIED=0 0=Quit, 1=Iconify, 2=Menufy on close

FONT=Topaz/8 Name/size of the font to use

STYLE=0 The style of font to use

POSONSTARTUP=0 Open window in the top left/centre of the
screen on startup

PUBLICSCREEN=GOLDED.1 The public screen to open the window on

CUSTOMSCREEN=EvenMore The name of the custom screen to create

SCREENTYPE=1 Whether or not to allow the window to open
on a custom screen.

CUSTOMDIM=640/256 Width/height of custom screen

CUSTOMDEPTH=3 Number of bitplanes in custom screen

CUSTOMOVERSCAN=1 Overscan settings for custom screen

CUSTOMAUTOSCROLL=OFF Autoscroll for custom screen

CUSTOMDISPLAYID=$8000 Custom screen display ID

DEFAULTPATH=ram: If no path/file is given on startup, this
path/file will be used.

DOCPATH=HELP:EvenMore.doc The file that will be loaded by pressing
HELP

EDITORSTR=c:ged %s The command line of a text editor for
editing files

USEFILETYPES=ON If true, any file that ends with a
configured filetype will be passed onto the
program it is configured for

GETFILESTATS=ON If true, EvenMore will count up the words,
characters, etc while loading a file
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CONFIGFILE=ENV:prefs The file to get the settings from

1.14 Window Positions

If the screen positions and sizes are commented out or are not there or if there
is no preferences file, the defaults will be used which are 640*200 positioned
top left hand side of the screen and using the default public screen.

If the POONSTARTUP option is enabled, then the window position values will be
overrided.

If you specify a size larger than the visible limits of the screen (The part you
can see), then the window will be moved and resized to suit. For example, if the
screen is scrolled down and the window opened, the window will be moved to the
middle of the remaining visible part if the POSONSTARTUP option is 2, and if the
window size is larger than the visible part, the window will be sized to fit.
This hopefully means that users of graphics cards will sleep better, knowing
they shall be able to view any time, any place.

1.15 Font

If the font you select could not be opened, EvenMore will let you know, and then
fall back to the system default font. If it can’t open the system default font,
then you are in trouble ;). You can select a font for viewing after EvenMore is
loaded.

Colour fonts are not supported, if you try them you will only get a black font
with other colours masked out. I’m not doing font colour remapping, or anything
like that. Also, It’s just too slow..... Proportional fonts are also no longer
supported. It is quite difficult to do scrolling when each character is a
different width.

1.16 Public/Custom Screens

If you specify a public screen to open the window up on that does not exist, you
can be sure the window will open on the default public screen such as Workbench
or DOpus (Hopefully not DOpus :). If you have the public and custom screen
option enabled, then a new screen will be created with the custom screen
settings, and the Workbench colours and font.

----------------------------------------------------------------------- HINT ---

Use MCPs default pubscreen patch to make the front screen into the default
public screen, if it is public. And you could use TruePub to patch screens that
are private to public screens to get EvenMore to open on any screen you want.

--- HINT -----------------------------------------------------------------------
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1.17 Editor

Note that the string you enter here is basically a command line. So you can
include options other than just the editor path.

Keyword... Replaced with...

%s Full filename
%l Top line of file in the window

For exmaple...

EDITORSTR=c:ged %s LINE=%l

1.18 Preferences File

Here is an explanation of the preferences file.

If there is a preference file ’ENV:evenmore.config’, or if you sepcify another
preference file, the above tooltypes will be overrided.

- - cut along here 8< - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

WINDOWPOS=0/0/640/256
TEXTOFFSET=5/5/5/5
FINDHORIZ=0
SEARCHNOTIFY=OFF
SMOOTHSCROLL=ON
QUITREQUESTER=ON
BORDERTEXT=1
BORDERGADGETS=1
GADGETSOFFSET=2
BORDERSOFFSET=2
GADGETSPOS=1
SWAPGADGETS=OFF
FILLBORDERS=3/3
DITHERFILL=0/0
ADDSCROLLERS=2
;PAGEOVERLAP=0
APPICONPOS=0/0
STARTAPPIFIED=0
ICONIFYONCLOSE=0
FONT=Times/13
STYLE=2
;POSONSTARTUP=2
PUBLICSCREEN=GOLDED.1
CUSTOMSCREEN=EvenMore
CUSTOMDIM=640/256
CUSTOMDEPTH=3
CUSTOMOVERSCAN=1
CUSTOMAUTOSCROLL=OFF
CUSTOMDISPLAYID=$500C1000
DEFAULTPATH=Work:docs
DOCPATH=HELP:EvenMore.doc
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EDITORSTR=c:ged %s
USEFILETYPES=ON
GETFILESTATS=ON
FILETYPE=#?.guide/multiview %s
QUICKLOAD=S:Startup-sequence
QUICKLOAD=Ram:
QUICKLOAD=Utilities:docs/
QUICKLOAD=S:User-startup
QUICKLOAD=EvenMore:docs/evenmore.doc
QUICKLOAD=S:Startup-sequence
QUICKLOAD=Ram:
QUICKLOAD=Utilities:docs/
QUICKLOAD=S:User-startup
QUICKLOAD=EvenMore:docs/evenmore.doc

- - - - - - - - - - - - - - - - - - - - - - - - - - - cut along here 8< - - -

The format of this file is half critical! Well, sort of.

--- DON’T!!!! ------------------------------------------------------------------

Basically values must come after the preset name.

No other text is allowed to be after the equals sign other than the value and
make sure you only have 1 equals sign in a line!

Also, please try not to have spaces after the value. EvenMore doesn’t trim the
spaces, which come at the end of the line. So take special care when entering in
screen names and fonts.

Also, the preset names must be UPPERCASE! (Due to the optimizations I have done)

--- DO!!!!!! -------------------------------------------------------------------

Text before the preset name is ok. You can comment out preferences by putting a
semi-colon at the very start of the line (Has to be the first charcter).

The preset order may be changed, for instance, I could put the POSONSTARTUP
option at the top and it wouldn’t make a difference.

--- WHY? -----------------------------------------------------------------------

You are saying, why am I mentioning all this? Well, you shouldn’t need to modify
the config file that often, but just to be sure that you don’t mess anything up,
and to save a few emails back and forth, and I might as well get it over and
done with.

1.19 The Project Menu

__________________________________________________________
[Project] View Search Execute Settings
| ¯¯¯¯¯¯¯¯¯¯¯¯T¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
| Close file |
| Load file... |
| Load new... |
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| Reload file |_____
| Quick load »| List |
| Editor | Add |
|-------------------‘------’
| Information... |
| Help... |
|--------------------|
| Iconify |
| Menufy |
| Quit |
‘--------------------’

Close file:
-----------

The file displayed in the window will be freed.

Load file:
----------

Allows you to select an ASCII file from a requester to display

Load new:
---------

The file you select from the requester that pops up will be passed onto a new
EvenMore being executed.

Reload file:
------------

Enables you to quickly reload the currently displayed file incase its contents
have changed. The line number you were at in the file (which is counted as the
top-most line in the window) will not be changed unless the file is shorter than
that line number, in which case, EvenMore will view from the end of the file.

Quick load:
-----------

If you select List from the sub menu, a window will appear. You can store paths
or drawers that you view regularly, so that you can quickly view them without
having to search through lots of drawers. The Load button will load the document
you selected, Load new will open up a new EvenMore and load that document. The
Add button will allow you to select a file to add to the list, and the Remove
button will remove the selected document from the list. The Up and Down buttons
will move the hilighted name up and down the list.

Selecting Add will add the current document name to the quick list.

Editor:
-------

The document will be passed onto a text editor for editing.

Information:
------------
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A window will pop up with several pages of information in it.

o About

Display information about the program.

o File

A requester will appear telling you the stistics of the file, including size,
lines, percentage viewed, words and characters.

Please note that the word count is based on my own idea of what characters a
word should comprise of, and the results will be different from word counting
mechanisms on other programs.

Help:
-----

A new EvenMore will load the EvenMore documents you have selected in the
prefernces.

Iconify:
--------

The EvenMore window will close, and an icon will appear on the Workbench screen.
Either double click on the icon, to bring the window back up, or drag some files
onto the icon and the window will appear again, and then the files you dragged
will be loaded, or you can even drag drawers onto the icon and a requester will
appear showing the contents of that drawer.

Menufy:
-------

The EvenMore window will close, and a menu item in the Workbench or DOpus Tools
menu will appear. Either select the item and the window will pop back up, or you
can select icons on the Workbench or DOpus screen and select the item, in which
case, the EvenMore window will pop back up and load the files you had selected,
or you can even select drawers with the menu item and a requester will appear
showing the contents of that drawer.

Quit:
-----

Exit the program.

1.20 The View Menu

__________________________________________________________
Project [View] Search Execute Settings
¯¯¯¯¯¯¯¯¯| ¯¯¯¯¯¯¯¯¯¯¯¯¯¯T¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯

| Go to line... |
| Go to page... |
| Go to percent... |
|-------------------|
| Top of file |
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| Page up |
|-------------------|
| Page down |
| Bottom of file |
|-------------------|___________
| Bookmark store »| Bookmark 1 |
| Bookmark recall »| Bookmark 2 |
‘------------------| Bookmark 3 |

| Bookmark 4 |
| Bookmark 5 |
‘------------’

Go to line:
-----------

Move directly to a line in the current document. Note that this number will be
taken as the top line of the window. So if I entered 4, EvenMore will display
lines 4 onwards.

Go to page:
-----------

Move directly to a certain page in the document.

Go to percent:
--------------

Move directly to a percentage of the file displayed. So If I entered 50 for 50%,
EvenMore will display lines from 50% backwards. 100% will view the end of the
file, and 0% will view the start of the file.

Top of file:
------------

Move to the top of the file.

Page up:
--------

Move up one height of the window.

Page down:
----------

Move down one height of the window.

Bottom of file:
---------------

Move to the bottom of the file.

Bookmark store:
---------------

In this menu item, there are 5 sub items. Use these sub items to store various
positions of the text. For example, if you are viewing a large document, and
there are several pieces of text you want to read, you can easily store the
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positions of these pieces of text, so you can easily find them later.

Bookmark recall:
----------------

In this menu item, there are 5 sub items. Use these sub items to move to a piece
of text you have previously stored using Bookmark store.

1.21 The Search Menu

_________________________________________________________
Project View [Search] Execute Settings
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯| ¯¯¯¯¯¯¯¯¯¯¯¯T¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯

| Find match... |
| Find previous |
| Find next |
| Find occurance |
‘-------------------’

Find match:
-----------

A requester will pop up, allowing you to enter, or modify a string to search for
in the document, or find thge number of times it occurs in the document.

If you click Next or Previous, EvenMore will try to move to the next or previous
string in the document that matches the one you entered. Then a requester will
appear displaying what line the match was found at, and EvenMore will scroll to
that line.

If you click Occurances, then EvenMore will scan the document for the number of
times the string occurs in the document.

There are also gadgets available for case-sensitivity, pattern matching,
word-sensitivity, movement and search notify. The word-sensitivity will not work
with pattern matching enabled, and pattern matching will not work with occurance
searches. The movement will make EvenMore scroll left and right to center a word
that has been found in the window, and search notify will make a requester
appear displaying the line the word was found at.

Forward searches begin at the second line below the first line in the window.
Backward searches begin at the line above the first line in the window.

Find previous:
--------------

This is the same ’Find match’, except no requester will come up. Instead the
search will start immediately using the last string you have entered. Then a
requester will appear displaying what line the match was found at.

Find next:
----------

Same as above except works in the other direction.
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Find occurance:
---------------

EvenMore will scan the document for the number of times the current string
appears in the document.

1.22 The ARexx Menu

_________________________________________________________
Project View Search [Execute] Settings
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯| ¯¯¯¯¯T¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯

| Execute... |
‘------------’

Execute:
--------

A window will open allowing you to enter a string, whether its a file or a
command line, to be executed by AmigaDOS or ARexx. There is a gadget which will
make a file requester appear allowing you to select a file.

1.23 The Settings Menu

_________________________________________________________
Project View Search Execute [Settings]
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯| ¯¯¯¯¯¯¯¯¯¯¯¯¯¯T

| Go to screen... |_______________
| GUI presets »|________________|
| Window position »|________________|
| Zoom »| Select... |
|----------------------| 200% |
| Change preferences...| 100% |
|----------------------| 75% |
| Load preferences... | 50% |
| Save preferences... | 25% |
‘----------------------‘----------------’

Go to screen:
-------------

A window will open with the names of all public screens in a list. Click on a
name, and click the Go gadget. If the screen does not exist, then the window
will not close. Click on the Read list gadget to get the latest list of public
screens open, incase any open or close after you open the window.

GUI presets:
------------

In this menu you will find some of my ’approved’ presets for the GUI.

Window position:
----------------
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You can select whether the window will position itself at the top left corner of
the screen, just under the title baror in the centre of the screen according to
its current size.

Zoom:
-----

The font will be resized by the percentage you select.

Change preferences:
-------------------

A window will open allowing you to set the following preferences...

o Appify

You can set the appicon positions, whether EvenMore should iconify or menufy on
startup, whether EvenMore should iconify or menufy when you click the close
gadget, and whether you want a requester to confirm quitting.

o File

If the Get file statistics gadget is true, EvenMore will find the number of
words, characters, etc while loading a file. You can enter filetypes into the
listview. Type in a filetype into the string gadget below the listview, and
click the Add gadget. To remove a filetype, click on the gadget in the listview
and press the Remove gadget. For exmaple...

#?.guide/multiview %s
#?.readme/c:ed %s

And you can set whether EvenMore will use these filetypes or load files as
normal using the Use filetypes gadget.

o Font

You can select the font, size and styles using the string gadgets, or you can
use the Select button to pick a font by the requester. The System and Screen
buttons will enter the system and screen font settings into the gadgets.

o GUI

You can set whether the text/gadgets should have a border around them, you can
set the amount of pixels between the window edge, borders and gadgets. You can
also select whether the border/gadget gaps should be filled, and whether the
fill should be dithered.

You can choose whether the gadgets should appear at the top, top and bottom, or
bottom positions, and you can swap the gadgets around.

o Paths

You can set the default path/file for when EvenMore opens without a file
selected, the EvenMore document for when you press the help key, and the editor
string for passing the current file onto a text editor.
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o Screen

In the string gadget, you can enter name you want the custom screen to have. The
Public screens only gadget means that EvenMore will not try to create any custom
screens whenever a screen cannot be found. Selecting Use custom screens will
make EvenMore create a new screen whenever a screen is not found. The name of
the custom screen you have entered will now appear in the Screen requester, even
if the custom screen is not open yet, allowing you to easily switch between the
public and custom screens. There is also a screenmode requester to allow you to
specify the settings for the custom screen.

o Text

You can set the number of pixels between one of the edges of the window and the
text. You can set the number of lines for the page overlap and enable or disable
the smooth scrolling.

o Window

You can edit the current window positions and dimensions, and choose whether the
window should be centred or in the top left corner of the screen on startup. You
can set which scrollers should be added to the window borders.

Click Ok, and the preferences will be kept.
Click Use, and EvenMore will save the preferences to the temporary preference
file, which is usually ENV:EvenMore.config.
Click Save and EvenMore will save the preferences to the temporary preference
file and also open a requester to select where to save the permanent
preferences, which is usually ENVARC:EvenMore.config.

Load preferences:
-----------------

A requester will appear allowing you to select a preference file. Then the
settings will be reloaded.

Save preferences:
-----------------

A requester will pop up asking whether you want to save or use the prefernces.

o If you select use, then the preferences will be saved to the
temporary preference file currently used by EvenMore.

o If you select save, then the preferences will be saved to the
temporary preference file currently used by EvenMore, and a filerequester
will appear asking where you want to save the permanent preference file.

o If you select cancel, no settings will be saved or used.

1.24 ARexx Port

You can use EvenMore’s arexx port to control EvenMore remotely. The port’s name
is ’EvenMore’, plus a number. This number will increment if a port of a similar
name is found, for instance if you load two copies of EvenMore, the first copy
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will have a port name of ’EvenMore.1’, and the second one will have a port name
of ’EvenMore.2’. You can find which port EvenMore is using by looking in the
About requester.

The commands are:-

’r’ indicates command returns a value

CLOSE . . . . . . . . . . . . Close current file
r GETFILENAME . . . . . . . . . Get name of the file loaded
r GETPATHNAME . . . . . . . . . Get path of the file loaded
r GETFILESIZE . . . . . . . . . Get size of the file loaded

LOADFILE <file> . . . . . . . Load file
RELOAD . . . . . . . . . . . Reload current file

POSWINDOW <0-2> . . . . . . . Top left/centre the window in the screen
r GETWINDIM <0-3> . . . . . . . Get dimension of the window, left/top/width/..

r GETTEXTOFFSET <0-3> . . . . . Get number of pixels between text and border
r SETTEXTOFFSET <0-3/pixels> . Set number of pixels between text and border

r GETFIRSTLINE . . . . . . . . Get number of the first line in the window
r GETLASTLINE . . . . . . . . . Get number of the last line in the window
r GETLINE <line number> . . . . Return text of a line
r GETTOTALLINES . . . . . . . . Get number of lines in the document

SCROLLTOCOL <column number> . Scroll to column in the window
SCROLLTOLINE <line number> . Scroll to line in the window
SCROLLTOPAGE <page number> . Scroll to page in the window
SCROLLTOPERCENT <percent> . . Scroll certain percentage down the document

BOOKMARKSTORE <number> . . . Bookmark current position in document
BOOKMARKRECALL <number> . . . Scroll to the position stored in a bookmark

r GETFONTNAMESIZE . . . . . . . Get name and size of the font used
r GETFONTSTYLE . . . . . . . . Get style of the font used

SETSCREENDEFAULTFONT . . . . Use screen default font
SETSYSTEMDEFAULTFONT . . . . Use system default font

r OCCURANCES <string> . . . . . Find number of times string occurs
r SEARCH <string> . . . . . . . Search for string in the document

LOADPREFS . . . . . . . . . . Load preferences from ENV:
SAVEPREFS <file> . . . . . . Save preferences
APPIFY <0-2>. . . . . . . . . Show/Iconify/Menufy window
QUIT . . . . . . . . . . . . Quit

Preferences commands - Use these commands to change the preferences

SEARCHNOTIFY <ON/OFF>
SMOOTHSCROLL <ON/OFF>
SWAPGADGETS <ON/OFF>
USEFILETYPES <ON/OFF>
CUSTOMAUTOSCROLL <ON/OFF>
GETFILESTATS <ON/OFF>
QUITREQUESTER <ON/OFF>
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FINDHORIZ <0-2>
ADDSCROLLERS <0-2>
POSONSTARTUP <0-2>
BORDERTEXT <0-3>
BORDERGADGETS <0-3>
GADGETSOFFSET <number>
BORDERSOFFSET <number>
GADGETSPOS <0-10>
PAGEOVERLAP <number>
STARTAPPIFIED <0-2>
CLOSEAPPIFIED <0-2>
STYLE <number>
LEADING <0-10>
SCREENTYPE <0-1>
CUSTOMDEPTH <number>
CUSTOMOVERSCAN <number>
CUSTOMDISPLAYID <hex number>

FONT <name/size>
PUBLICSCREEN <string>
CUSTOMSCREEN <string>
DEFAULTPATH <string>
DOCPATH <string>
EDITORSTR <string>
CONFIGFILE <string>

To use one of these commands from a shell, you could simply type the following:-

RX "ADDRESS ’EvenMore.1’; LOADFILE ’s:startup-sequence’"

Note the quotes which must be put around some strings when characters like ’:’
are present in them. If you do not specify a filename for LOADFILE or if you
just specify a path, then a requester will open. If you do not specify a line
number for GETLINE, NIL will be returned.

You can also pass the name of a script to EvenMore, and it will be executed.
For example...

RX "ADDRESS ’EvenMore.1’; ’rexx/testport.rexx’"

- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - >8 - - - - -

/* Test port */

address ’EvenMore.1’

options results
"getpathname"
path = RESULT
"getfilename"
file = RESULT
"getline 2"
line = RESULT

say ’Path = ’path
say ’File = ’file
say ’Line 2 = ’line
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exit

- - 8< - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

1.25 Movement

There are several keys for moving about the document displayed in EvenMore’s
window.

*** Cursor keys ***

UP CURSOR Scroll text up one line
DOWN CURSOR Scroll text down one line

LEFT CURSOR Scroll text left one column
RIGHT CURSOR Scroll text right one column
------------------------------------------------------------------------------
SHIFT + UP CURSOR Scroll text up one page
SHIFT + DOWN CURSOR Scroll text down one page

SHIFT + LEFT CURSOR Scroll text left one page
SHIFT + RIGHT CURSOR Scroll text right one page
------------------------------------------------------------------------------
ALT + UP CURSOR Move to top of text
T Move to top of text
ALT + DOWN CURSOR Move to bottom of text
B Move to bottom of text

ALT + LEFT CURSOR Move to left extreme of text
ALT + RIGHT CURSOR Move to right extreme of text

*** Numeric keypad ***

8 Scroll text up one line
2 Scroll text down one line

4 Scroll text left one column
6 Scroll text right one column
------------------------------------------------------------------------------
9 Scroll text up one page
3 Scroll text down one page
------------------------------------------------------------------------------
7 Move to top of file
1 Move to bottom of file

*** Other keys ***

ESC Quit
SHIFT + ESC Iconify

RETURN Search next
SHIFT + RETURN Search previous

HELP A new EvenMore will open and load the EvenMore docs
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F Activate filename string gadget
S Activate search string gadget

SHIFT + LOAD GADGET Load new

+ Zoom in 10%
- Zoom out 10%

You can use the drag bar and the up and down gadgets in the right window border
to scroll around the text file. Also, you can click the left mouse button in the
window and drag past any border of the window, and the text will scroll up or
down or left or right. The larger the distance you move the mouse from the
window, the faster the text will scroll.

The underscored letters of the gadgets in the window can be used as short cuts.
For example, pressing the C key on the keyboard will carry out the function of
the gadget that has the letter C underscored, which is the close gadget.

And you can also use the shortcut RIGHT-AMIGA + ? keys in the menus too.

1.26 File Loading

A dead easy way of loading files, is to simply drag icons from the DOpus screen,
or Workbench screen onto the the window. EvenMore will then load the files you
dragged. You can also drag files onto the EvenMore appicon (Appears when
iconified) and the window will appear and the files you dragged will be loaded.
Or you can select icons, and select EvenMore from the Tools menu when menufied
and EvenMore will load those files. Of course you can even select drawers
instead and a requester will appear showing the contents of that drawer.

1.27 History

-------------------------------------------------------------------------------
0.4beta3
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Added gadget help bubbles. Just leave the mouse positioned over a gadget, and
a help bubble appears. Thanks to Will Harwood for the code. (Although I did
modify it slightly).

o Cleaned up smooth scrolling routine a bit.
o Increased maximum zoom to 200%.
o Now + and - keys will zoom in and out by 10%.
o Added percentage of zoom to the window title.
o Limited text offset maximum to 10.
o Added Soft fade and Plain look to GUI settings menu.
o Added Random look to GUI settings menu.
o You can now have a box drawn around the gadgets or text instead of a bevel

border.
o Renamed the preferences, BEVELSOFFSET to BORDERSOFFSET, BEVELTEXT to

BORDERTEXT and BEVELGADGETS to BORDERGADGETS.
o Removed some unecessary exception handling.
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o Made ’failed to allocate memory’ exceptions more specific about what actually
went wrong.

o Removed ’Loading...’ message from window title, as it is not needed as there
is now a progress window.

o At last worked out I needed to use 32bit multiplication and division in order
to calculate the progress window percentage, instead of using a lot of
division to break it down into smaller numbers.

o Optimized some scroller gadget code.
o Now only the text and not the GUI is redrawn when zooming.
o Replaced zoom requester with a GUI with a slider, in which you can test, use

or cancel the zoom.

-------------------------------------------------------------------------------
0.4beta2
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Added search requester gadget to window.
o Added preferences for quit confirmation requester.
o Added zoom percentage requester.
o Fixed horizontal scroller bug in searches.
o Added Left justify movement to search.
o Merged About and File statistics windows together.
o Bevelled progress bar.
o Replaced font string in preference GUI with a text and number gadget, and

removed font style checkmarks.
o Rearranged File page of preference GUI and search GUI.
o Now only screens of Hires and larger are selectable to ensure the GUIs will

fit on the screen.
o Replaced TRUE and FALSE with ON and OFF in preferences.
o Enhanced tab GUI plugin to look nicer. Thanks to Ralph Wermke for the EasyGUI

plugin.
o Added text gadget in preferences to display current screenmode of custom

screen. Thanks to Eric Sauvageau for the help.
o Cleaned up some illegal variable coding. (There’s probably loads more)
o Fixed annoying bug where some preferences would trash. It was a stupid

mistake.
o Fixed bug in which progress bar would appear on the wrong screen.
o Fixed bug in preference loading, to do with the quit requester.
o Hopefully screenmodes with no name will now get a name given to them.
o Fixed bug where main window would fail to reappear after closed and opened

if the custom screen can’t be opened.

-------------------------------------------------------------------------------
0.4beta1 Ummm... Hello there
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Added %l keyword to editor string, etc, which will be replaced with the top
line in the window. Thanx to Sven Steiniger for the code.

o Merged WINDOWPOS, TEXTOFFSET and APPICONPOS and CUSTOMDIM preferences into
strings seperated by slashes.

o Shift Esc will now iconify.
o Removed Load new gadget. Hold Shift when you click the Load gadget to load

a new file.
o Added preferences for enabling/disabling scrollers.
o Added progress widow when loading files.
o Added Up and Down gadgets to listviews.
o Added Copy gadget to listviews.
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o Fixed slight bug in gadget bevel.
o Replaced old listviews in preferences GUI with the dclistview plugin. Thanks
to Victor Ducedre for the code.

o Added keys T and B for moving to the top and bottom of the document.
o Replaced a few MX gadgets with CYCLE gadgets in the preference GUI.
o Added preferences for having only the right scroller enabled.
o Added Raised look to GUI presets.
o Added preferences for filling/dithering the gadget gap.
o Was calculating window dimensions twice on resize, and making lots of

calculations for a window move which wasn’t needed. Now fixed.
o If a filename doesn’t exist, the file requesters will now split the filename

into path and file strings, instead of just the path string.
o Removed the need to have the run command, by using the runback() function

by Sven Steiniger.
o Added zoom menu to settings menu.
o Added preferences for menufying on close.
o Added Add menu item to Quick load sub menu.
o Tidied up calculating the window dimensions.
o Fixed bug in the Project menu.
o Return and shift return will now search.
o Screen will now flash when search fails.

-------------------------------------------------------------------------------
0.4beta0 Watch this space....
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Minimum window size now calculated properly. If the window is too small for
the new preferences, the window will resize to make sure at least one line
and column is displayable in the window.

o Added search gadgets to the window
o Added keys F and S which activate the filename and search string gadgets.
o Added leading preferences to allow you to leave a gap between the lines.
o Removed font menu items fron Settings menu and added Font preferences to the

preferences GUI.
o Added Window GUI to the preferences GUI for editing the window positions etc.
o Added preferences for switching the gadgets around.
o Rename the Bevel preferences to GUI, and added preferences for changing the

gadgets positions (Top/top, Top/bottom, Bottom/bottom).
o Merged font name and size preferences together.
o Added preferences for the ability to pass AmigaGuide files on to an

AmigaGuide viewer.
o Fixed bug where opening a new EvenMore, opening an AmigaGuide file or opening

the editor would fail because of spaces in the name.
o Removed the AmigaGuide preferences and added the ability to configure any

filetypes you want.
o Removed quickload and filetype preferences from EvenMore icon. Use preference

file if you want these features.
o Enhanced arexx port to allow you to change a lot of preferences.
o Merged STARTICONIFIED and STARTMENUFIED preferences.
o I understand exec lists a lot better now, and cleared out a lot of code I

didn’t need from the function to get the screen list.
o Added Read list button to the screen requester for updating the screen list.
o Fixed crash when unable to lock a public screen, like the TextView screen.

Will get the default public screen when this happens.
o Added preferences, requesters, etc for the ability to create a custom screen.
o Renamed Script menu to Execute menu, and added a requester that allows you

to execute command lines.
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o Merged all the Execute menu items together into one GUI.
o Added File page to the preference GUI, and moved the filetypes from the Paths
page to it.

o Added preferences for turning on and off finding the file statistics while
loading.

o Removed tab gadgets from preference GUI as they take up too much space.
Replaced them with a listview.

o Added preferences for positioning the window in the top left corner of the
screen on startup, and added a menu item to do this while EvenMore is
running.

o Fixed bug in which TEXTOFFSETs were loaded in the preferences in the wrong
order.

o Added preferences for filling the gap between the window border and the
bevel offset.

o Added preferences for making the filled borders dithered.
o Added menu with a few GUI presets in it. Send me your cool presets now! :)

I think the Plastic look is the best.

-------------------------------------------------------------------------------
0.3beta9 New World Order still on schedule for 2000
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Maximum width and height of scrolling reduced from width of window to maximum
width and height of text.

o Uses extra copy of rastport for BACKGROUND_PEN so I don’t have to keep
switching back and forth.

o Added ’%s’ keyword for the editor string.
o Fixed bug in which search menu options would reset after the window is

reopened even if the options themselves hadn’t changed.
o Added prefs for the docs file, so the EvenMore docs can be loaded when you

press the help key.
o Removed direction toggle item from search menu and added ’Find previous’ item

so that you can change the search direction with less hassle.
o Go to screen listviews can now be double clicked.
o Added Next and Previous buttons to the search requester.
o Removed word, pattern and case senitivity toggle items from the search menu

and replaced the Match requester with a GUI with these functions in it.
o Removed quickload menu items and replaced them with a listview requester.
o Added Load new button to the quickload GUI.
o Removed quickload file limit from preference file, but not from icon yet.
o Added Help menu item in Project menu.
o Removed Occurance requester and added an Occurance search button into the

search GUI.
o Search requester will not disappear after you have searched for a word, or

the occurance of a word. I had to remove the smooth scrolling in searches
so that EvenMore would be able to scroll to the word while the window is
inactive.

o Removed the Find horizontal menu item and added a Find horizontal gadget
to the search GUI.

o Added preferences and a gadget to the search GUI to enable or disable the
search results requester from appearing.

o Hopefully fixed bug in which EvenMore would go into a continuous loop trying
to open the system default font if opening the system default font failed.

o Fixed bug in which the text area wasn’t calculated properly due to mix up
with text offset values.

o Replaced Text offset menu items with a GUI.
o Renamed Text offset window to Window preferences and moved the smooth
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scrolling and bevel border menu items into the window.
o I was using the page overlap preferences for horizontal scrolling, which

would cause problems as this is calculated according to how many lines are
in the window, and not how many columns, so I removed it from the horizontal
scrolling.

o Added Path preference GUI and menu item.
o Removed Iconify on close menu item, and added an Iconify preference GUI and

menu item.
o Merged preference GUIs into one GUI using the EasyGUI tabs plugin.
o Removed error suppression. It was silly :).
o Added Add and Remove buttons to the quick load GUI.
o Added two file requester gadgets to the path strings in the preferences.
o Added Save and Use preference gadgets to the preferences GUI.
o Added new preferences for making bevel borders recessed, adding bevel borders

around the gadgets, and setting the number of pixels between the bevel
borders, the gadgets and the window edge.

o No longer crashes when there are no lines displayable in the window.

-------------------------------------------------------------------------------
0.3beta8 Are you ready to face eternity?
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Uses AsyncIO file loading for speed.
o No longer reloads icon every time you iconify.
o Added prefs and a gadget for passing the file onto a text editor.
o If the window is resized smaller than the width of all the gadgets, any

gadgets that don’t fit on the end will be removed, and the string gadget will
expand to fill the gap.

o Now checks properly to see if a path is a file or drawer to work out whether
to open the file requester.

o Partly fixed bug in which the window could be opened really small.
o Added gadget and menu item for opening a new EvenMore and loading files.

You can now also select multiple files from CLI, or icons when running from
Workbench, or select multiple icons when iconified or menufied.

o Fixed bug in which program would crash if a file failed to load due to
running out of memory.

o Silly me. I had removed the clearing of the top window border thinking I
didn’t need to clear it, when I did.

o Added horizontal scrolling.
o Removed proportional font support due to horizontal scrolling.
o Removed printing of line/page/percent in the window due to horizontal

scrolling.
o Added prefs and menu item for a bevel border around the text.
o Word searches now scroll horizontally to centre the word in the middle of the

window.
o Doubled the amount of quickload files.
o Added prefs and menu item for scrolling horizontally in searches.
o Renamed ARexx menu to Script menu, and added a DOS script execute menu item.
o Added font style preferences.
o A few optimizations...
o A few other things not worth mentioning...

-------------------------------------------------------------------------------
0.3beta7 The end is nigh!
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Fixed stupid bug where the file would be reloaded if you switched screens
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when the window opened for the first time.
o I’m really loosing it. Fixed another bug in which the window would not

remember the top left position it was at after switching screens.
o Added basic ARexx port.
o Fixed another bug. This time in the start iconified/menufied routines.
o Window now gets locked when the screen requester is open.
o Improved preference file loading again.
o Fixed bug where window would always centre on loading.
o Added the ability to save most of the preferences from the settings menu.
o Added load preferences item in the settings menu.
o Added the ability to store bookmarks.
o Added the menu item Go to page.
o Added page number printing options.
o Changed the way lines are stored in memory, so searches and things should be

a tiny bit faster.
o Added Execute script in an ARexx menu.
o Optimised the way the rexx port works.
o Added default path setting.
o Added quick load menu.
o Enhanced string and pattern finding functions.
o Added gadgets inside the window.
o Added iconify on close preferences and menu item.
o Added gadget shortcut keys.
o And a few more things not worth mentioning...

-------------------------------------------------------------------------------
0.3beta6 We’re members of the lollypop guild...
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Can take just a path as an argument, and a requester will pop up with the
directory listing of that path displayed.

o Fixed stupid bug in which EvenMore would crash if there were no linefeeds
in a file.

o Can now be menufied into the Workbench tools menu.
o Added preferences for menufying on start-up.
o Fixed major bug in the tooltypes. They didn’t work, and on some machines

caused a 4-5 second freeze before doing anything.
o Fixed a silly bug in which the Quit from the menu didn’t work.
o Made scrolling slide smoothly along.
o Added preferences for smooth scrolling.
o Added centre window menu item.
o Added page overlap preferences.
o Added sub items in the settings menu for the text offsets.
o Added the ability to drag and drop and select from the menu drawers as well

as files. A requester will appear displaying the contents of that drawer.
o Tidied up some code and fixed a few bugs.
o Added screen list. I had to use EasyGUI to create it, as there is no such

requester in ReqTools, and EasyGUI beats MUI and BGUI and CrashAct.
Unfortunately, it takes up an extra 30k of code, so hopefully soon I will
have added a few more things in EasyGUI to make up for that.

o Added system default font menu item.
o Made program breakable when iconified or menufied.
o Added close file menu item.
o Removed the ’could not find file’ error message. Now the window will open

even if a file was not found.
o Added ’no files loaded’ notice, when no file is found. Also it replaces the

statistics message when no file is loaded.
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o Speeded up things by removing all window, drawinfo and screen, etc. pointer
arguments from procedures, and put them all in a global object.

o Added mouse movement.
o Decided to remove the space line between rows in the window. This will speed

things up, and be more compatible with text snapping programs.

-------------------------------------------------------------------------------
0.3beta5 Onward... To vitory!
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Reversed scrolling upwards, so it now looks nicer.
o Lost a few bytes to OO programming after making code a litte tidier.
o Further prefs/file loading optimizations and clean sweep.
o Window can now be iconified.
o Added appicon positioning preferences.
o Fixed up the ReqTools requesters a bit, with pattern matching, and window

locking.
o Added the option to be iconified on start-up.
o Added ’Go to percent’ menu item in the view menu.
o Made space between text and window borders configurable.
o Added line number printing options.
o Added the settings menu with the line number printing item.
o Added line percent printing options.
o Added the settings menu with the line percent printing item.
o Removed window clears, so now when the window is resized or the window is

scrolled more than the number of lines in the window, the text will simply
redraw over the old text.

o Uses BlitCopy() instead of ScrollRaster(). The raster is copied, just
like ScrollRaster(), but the new area isn’t cleared. The lines are drawn on
top of the old lines, which is much nicer to look at. This may also mean
scrolling is slightly faster.

o Remade most of the search functions.
o Added ’File statistics’ menu item, showing more information like word count,

and number of characters in the file.
o Added font requester, and the select font item in the settings menu.
o Added screen default font selection in the settings menu.

-------------------------------------------------------------------------------
0.3beta4 We’re on the right track now...
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Text printing vastly improved. Now a whole window redraw is not necessary
if the viewer scrolls more than one line. The scroll is done and the lines
are just filled in.

o May have fixed a small mistake in which the bottom border could be trashed
by the font on a redraw. (Not the major trash if you resize too fast).

o Window now calculates the minimum size possible it can be by the gadget
sizes.

o Made errors output to requesters if opening the ReqTools library was a
success, otherwise outputs to the console.

o Even more (excuse the pun ;) optimizations!!!
o Changed the way file is loaded. This may save some memory/speed? And it

will also mean that I can easily make changes, etc, when I work out how to
parse the file.

o If a file doesn’t exist when selected by the requester, the old filenames
will be restored.

o Added font preferences.
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o Added error suppression.
o ’Discovered’ how to set the writemask on a rastport, so now the window
scrolls mega fast!

o Added an AppWindow, so files can be loaded by dragging icons onto the window.
o Now when you switch screens, the window dimensions aren’t lost.
o Half finsihed a scroller window. Scrolling left and right will be deadly. If

anyone knows how let me know. I have some idea, of how to do it, but it is
hard turning that idea into code.

o Now ignores carriage return characters, for PC compatibility.
o Numeric keypad support.
o Fixed a few bugs.
o And a few other things not worth mentioning...

-------------------------------------------------------------------------------
0.3beta3 Not another re-write! The 487th re-write this month!
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Fixed silly bug in which sometimes the preference file wouldn’t open. (I
hope I did anyway).

o Window maximum and minimum sizes are now calculated according to the
visible limits of the screen, so hopefully no gurus should occur on virtual
Workbenches.(I hope)

o Tonnes and tonnes more optimizations.
o Flipped preferences file around. (It didn’t occur to me there was another

way to do it easily)
o Added the ability to move the window to a different screen after it is

opened.
o Now checks for the availability of a screen, by the

LockPubScreenList() instead of just trying to open on the default screen if
LockPubScreen() returns NIL.

o Hopefully improved the output of error handling.
o Changed the way preferences are loaded. This may save some memory/speed?
o Fixed bug in which the preferences would not load from the root directory of

my harddrive.
o Fixed bug in which the program would crash on exit.
o Now checks some keys by qualifiers instead of rawkey numbers.
o Can be killed by CTRL C.
o Added newlook menus for v39+.
o Text no longer trashes right border.
o And a few more things not worth mentioning...

-------------------------------------------------------------------------------
0.3beta2 We’re... forever... making improvements!
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Fixed silly mistake. Changed drawmode back from Jam2 to Jam1. I don’t know
how many times I have done this. :)

o More keys for moving about documents.
o View menu to move about documents.
o Added extra requesters.
o Added reload menu item.
o Added more information in about requester.
o Added more information in the title bar.
o Now uses ReqTools library.
o Added centring window option.
o Added preferences file.
o Search menu to search through documents.
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o Made a whole lot of optimizations.
o Removed GIMMEZEROZERO flag, so now the window updates faster and uses less
memory.

-------------------------------------------------------------------------------
0.3beta1 After a long while, I got interested again :)
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Added tooltypes. (Window size positions)
o A few improvements here and there.... here, there, everywhere a few

improvements!
o Fixed some silly bug. If started from the CLI, the files wouldn’t load up

from the requester... Thanx to Johan Björnson for reporting it. Still don’t
know who the culprit was that made the bug :?/.

-------------------------------------------------------------------------------
Pre 0.3beta1 Kicking off
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -

o Can’t remember what they were like. Probably awful! Infact, so awful I just
erased them :).

1.28 Bugs

----- ANNOYING -------------------

o The ARexx port hardly works at all. I don’t actually understand how it works
yet, so it’s hard to fix.

o Executing an ARexx script that doesn’t exist will freeze the computer on
exiting.

o Freezes when the preference GUI is too large for the screen.

----- HARMLESS -------------------

o Italic text will trash the borders, not scroll properly, etc.
o Program fails to load files from the PROC: device. It seems that the PROC

device gives a false filesize for files. This also confuses ReqTools file
requesters. So blame the author of PROC: and kindly ask him to fix it :).
Also, this should be a warning to you. Proceed carefully when loading files
from virtual devices.

o ReqTools requesters don’t seem to close the font they use after they
have closed (Like the screen font used in the requesters), so you end up with
a massive open count for a font. This is strange. Maybe Magnus could
explain...

o I think a gap may appear between the right side of the window and the gadgets
if the window borders are a different size than the screen borders.

o The file will still be loaded even if you put a / after it. This is because I
use Examine() to check if it’s a file or drawer.

o The keypad movement doesn’t seem to work on this A3000.

Help me crack down on bugs. You can never rid a program of all bugs, that is why
I need your help tracking them down. Please report any bugs you find. Also, if
EvenMore acts in any way you wouldn’t normally expect a text viewer to, then
please tell me.
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1.29 To Do

EvenMore is pretty scary at the minute. Soon though, once I get the main
features plugged, I will have time to think about putting in the diddly bits.
That is, if I find out how to do the diddly bits! So these are just
considerations, I have not actually thought about how I am going to do any of
this stuff. (Pledge a donation for software and books to educate me :)

+ = Really depends on a lot of things. Don’t care/not useful/low priority.
+++++ = Yes, I must get this done as soon as I possibly can.

***** = This is very improtant! Maybe even so important, there won’t be another
release until it happens!

-------------------------------------------------------------------------------

***** o Make more compact optimized code.

****+ o ASCII codes such as TAB and CR will be sensed and acted upon.

***++ o ESC sequences or ANSI codes sensed such as BOLD, etc. (Some sort
of text/file parser will need to be written)

++++ o Maybe create an iconify gadget for the window.
+++ o Make program auto-detachable from the CLI.
+++ o Make a recent file menu, where every file you have loaded is stored.
++ o Make scrolling move pixel by pixel. This is pretty tough, as it

invloves lots of maths. Maybe there are some examples?
++ o Get binary file detection written. But remember, it’s a text viewer!

It doesn’t do anything more, and never will never evolve into
anything more, as I am putting intelligence into my creation! I am
doing all the work, not evolution!

+ o Word hi-lighting in searches perhaps.
+ o Printing options. In the far distant future. If I am bored.

1.30 Author

This program is...

________________________________________________________________________________
::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::
e! Freeware! Freeware! Freeware! Freeware! Freeware! Freeware! Freeware! Freewar
::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯
Freeware:
------------------------------------------------------------------------------
A type of distribution agreement in which the author of the program retains
the copyright of the program, even though the software may be freely available
to all. Please note, freeware IS NOT Public Domain (PD).

If you decide it is slightly useful, or just a load of crap, or even shows some
potential, please email me (If you wish... But I really do want feedback on what
you think of it, how many users have tried it, etc). If you have any suggestions
or would just like to say that there is a 12-pack of Pepsi on its way to me then
again, please email me. :) HEY! Come on. Aminet wouldn’t be as big as it is, if
there wasn’t that many of you. There is no way just 7 + people have downloaded
this archive. Get your emails in! This program only survives by your feedback
(And if Christ’s return has not occured yet).
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Any users that do send an email have the benefit of being in my address book in
my email program. Any users that ask to become beta-testers can become one, and
can test any new features (Though they may be few), and test any Aminet releases
that are about to be uploaded.

1.31 Contacting cHRISPi

______________________________________________________________
[O|##Contacting#cHRISPi####################################|\textdegree{}|B]
|¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯| :
| Postal address: | ::
| Chris Perver, __ __ | ::
| 12, Orchardville Avenue, / // / | ::
| Bangor, / // / | ::
| Co. Down, / // / | ::
| N. Ireland, __ __ / // / | ::
| BT19 1LP. \ \ \/ // / | ::
| \ \/ // / | ::
| ______________________ \ V /V / | ::
| EMAIL:[chris@planb.thegap.com] V_/V_/ | ::
| ¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯ | ::
| ________________________ | ::
| URL:[http://planb.thegap.com/] | ::
| ¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯ | ::
| | ::
| And remember! Windows is rubbish! | ::
| | ::
|_____________________________________________________________ | ::
[############################################################|/] ::
¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯¯ ::
:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::
:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::

I cannot expect to be able to develop this program much further, as I am a
Christian and believe Jesus Christ will return very soon. If I do not reply to
any mail for months and months, then the development of this program has ceased.

1.32 Help

If any of you lot want to help in the distribution files, go ahead and email me.
You could design a few NewIcons, MagicWB icons, Iconographics icons, or
anything.

If you have any suggestions or contributions for the distribution files, again
email me. :)

Suggestions for the program (Not too hard ones now! At least until I finish the
main bits) are always welcome. Tell me what YOU would like to see in a text
viewer (Don’t just say ’some text’! ;).

Programmers! Please aid me. Maybe some tutorials or example sources of Workbench



EvenMore 0.4beta3 - AmigaGuide® Documentation 32 / 32

E stuff, parsing, raster tips, detaching processes, optimization tips, scroller
windows, etc. would be handy. Maybe Libraries documentation might be handy until
I save up enough money for the RKRM Libraries manual.

1.33 Thanz’n’Greetz

=========================================
THANX ’N’ GREETZ (In no particular order)
=========================================

This archive was put together by:-

Me - Everything :)
Mum & dad - RKRM manuals, Amiga 3000... (you name it, they provided it)
Johan Björnson - AmigaGuide, lots of suggestions, icons...
Mikael Grahn - Suggestions
Per Reidar Verlo - Lots of suggestions
Damien McKenna - Suggestions
Girish Nath - Icons

Without the following people, writing this program would have been virtually
impossible...

Nico François - ReqTools
Magnus Holmgren
Dietmar Eilert - GoldEd
Wouter van Oortmerssen - AmigaE and EasyGUI
J R Hulance - EasyGUI and AmigaE help

Ilan Sharoni - Word wrapping help
Marco Talamelli - ReqTools help
Eric Sauvageau - Screenmode help
Victor Ducedre - dclistview EasyGUI plugin
Ralph Wermke - Register EasyGUI plugin
Sven Steiniger - patternStringF, runback code
Will Harwood - GadgetInfo code

And all the good friends on #Amiga for testing, suggestions, etc. :)

If you are not listed here and you have helped me produce EvenMore, then I have
probably just forgotten about you :). But don’t fear, get in touch and let me
know!
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